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Otto
27 year old owner of a security installation business. Confident, Hands on, Practical. He employs 

three teams of five people and spends most of his time supervising his teams in the field.

Meet the BOSSES

SAMMY
39 year old owner of a promotional gift supplying company. Focused, Curious, Driven. 

He employs a sales team of 10 people and spends a lot of time actively sourcing new business.

Sue
35 year old owner of a small events management company.  Go-getter, Efficient, Demanding.
She employs five assistants and has alliances with many speciality service organisations.

BReNDA
42 year old owner of a small retail store called Funky Fashion. Ambitious, Chic, Creative.
She employs six people and does her own marketing material.
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mssatalk@microsoft.com
Microsoft is committed to helping Small Businesses succeed!
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will give you professional guidance relating to your specific needs.
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SMS:
Solly (Driver)
2011.09.17
06:55 AM

Off Sick,
SOrry!

wheeeuw!
what a day!

juSt another day
at the office!
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We all know that running a small business 
requires serious business savvy, personality, a 
sense of humour and the ability not to be too 
hung up on your job description. As CEO of your 
own company, rolling up your sleeves and getting 
your hands dirty if you need to is something that 
is often more the rule than the exception. It is this 
kind of dedication that makes small business very 
special and close to the hearts of those that live it 
to the maximum every day.  

This book is for those of you who survive on 
a daily diet of organised chaos. If the thrill of 
getting through a to-do list never loses its 
appeal, inspiring your staff puts a skip in your 
step and fulfilling a great idea before lunch is 
an adrenalin rush, then you’re definitely The 
BOSS, and Microsoft salutes you!

The demands and diversity to which small to 
medium business owners and managers are 
subjected is something not fully understood by 
anyone who hasn’t been there and experienced 
it themselves. Microsoft understands these 
demands and continually strives to offer 
solutions that will streamline and help small 
businesses reach their full potential and 
beyond.  

The Book of Small Business Solutions will show 
you how Microsoft technology can streamline 
your processes, letting you spend more time 
on important jobs such as customer service 
and growing your business.

INtRoDuctIoN

Information technology and 
business are becoming inextricably 
interwoven. I don’t think anybody 
can talk meaningfully about one 

without the talking about the other.

“ “

Bill Gates
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MicroSoft can help! this guide will shed some light on these and other key areas 
that can assist small business operations to run smoother and smarter. read on....

20% of small businesses do not 
use a pc to manage customer 
and supplier relationships.
Microsoft will show you how to
serve your customers better.

18% of companies surveyed had 
not yet embraced the internet.
Have you? Microsoft will show you how 

to get online and on track!

Small businesses 
spend an average of 
R60K developing their 
marketing materials. 
Microsoft can show you how 
to do it yourself, with a huge 
cost saving  benefit.

30% of small business 
managers spend up 
to three hours a week 
looking for information.
Microsoft can show you
how to find what you need 
quickly and efficiently.

loss of data is one of the 
key factors contributing 
to business inefficiency.
 
Do you back up your data daily? 
Microsoft will show you how, it’s 
easier than you think.

it security failures cost 
two thirds of businesses 
surveyed an estimated 
R12K per year
 
Are you at risk? Microsoft 
can help make your IT 
infrastructure watertight.

Does any
of this
sound

familiar?
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There is a lot of IT jargon flying around. To help you out, here are handy explanations for some of the 
common terms and options you could come across: 

Cloud Computing

Instead of running software applications on your own PC, with cloud computing your 
applications are hosted online, which reduces IT costs. For more information on cloud 
computing, go to page 47.

Windows Live SkyDrive (available free of charge)

Store, organise and share up to 25GB of files for free - and collaborate in real 
time with Office WebApps. You control who has access to your data, which 
can be viewed on both PC and Mac. You can also save data captured on your 
Windows Phone and then synchronise later. Find out how on page 21.

Smartphones

These are advanced mobile phones that have some of the functionality of a PC, with 
features such as Internet access, calendar and email. Microsoft’s Windows Phone 7 offers 
a high-resolution multitouch screen, 5-megapixel camera and support for Microsoft Bing 
search, Xbox Live gaming and an advanced Internet Explorer Web browser. It includes 
the full suite of Office 2010 Mobile applications, with mobile versions of Word, Excel, 
PowerPoint and OneNote as well as email, diary and contacts via Outlook. 
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Laptops, Netbooks and Slates

Versatile and comprehensive, laptop computers can be easily transported and 
used in temporary workspaces such as on aeroplanes, in libraries, at meetings, etc. 
A laptop will generally cost more than a desktop PC with the same capabilities. 
Netbooks are more affordable laptops, but they are generally less powerful and 
often do not have a DVD drive. They are best suited for highly mobile users. 

Tablet PCs are mobile computers with a touchscreen that you can write on with a 
tablet pen instead of using a keyboard and mouse. Slate Tablet PCs have no lid or 
keyboard, which makes them slim and light. You can hold a Slate Tablet PC in one 
hand and write on the screen with the other handv and you also have the option to 
attach an external keyboard and mouse.

New hard drive technology

Solid-state drives are a new type of hard drive that use flash memory and do not have any 
moving parts. They’re faster, lighter, more shock resistant and use less power. However, 
they are also considerably more expensive than conventional spinning hard drives. At the 
moment the capacity of these drives is generally smaller than typical laptop hard drives, 
though that might change in the future.

Servers

A server is a system in which a central server provides data to a number of 
networked workstations. There is a false belief that servers are solutions for large 
organisations only. But a server can be beneficial addition to the small business 
environment as well, as you will see in the next section.

The computer is no better 
than its program.
Elting E. Morison

techNo tAlk
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Do you face issues like this?

 

It doesn’t need to be this way!

If you need a simpler and more convenient way
to protect your business data, share information
and run line-of-business applications, it’s time to
consider investing in a server.

Making use of servers 
is not something 

reserved for large 
companies and they 

don’t need to be overly 
expensive or complex.

I’m concerned 
about losing 
all my data if 

my PC crashes.

It’s always hard 
to find the exact 
files I want when 

I need them.
I wish I could 

access my files 
from outside the 
home or office.” 

Servers are
too complex and 

costly for me 
to manage and 

maintain.” 
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A server can help you organise and secure your business data, 
enabling you to get more done while saving time and money.
With a server, you can: 
• Protect critical files or business information from disaster or theft and perform 

virus management 
• Share and access resources such as data and printers centrally 

• Stay connected and up-to-date when working out of the office  

• Run your critical business applications 
• Benefit from increased reliability because servers are designed to run at all 

times 

• Perform backups reliably and quickly with all of your data stored in a 
centralised location

WHAT CAN A SERVER DO FOR YOu? 
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Start by identifying the server that’s right 
for your needs. The table on the next page 
summarises the servers that Microsoft 
recommends for small businesses: Windows 
Server 2008 R2 Standard and Foundation 
Server, and Windows Small Business Server 2011 
Essentials and Standard.

Available for both Standard and 
Essentials editions, Windows 
Small Business Server 2011 

Premium Add-On offers you a 
flexible and cost-effective solution 
for purchasing additional servers.
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Windows Server 
2008 R2 Foundation

Windows Small 
Business Server 2011 
Essentials

Windows Small 
Business Server 2011 
Standard

Windows Server 
2008 R2 Standard

Overview Cost-effective, entry-
level technology 
foundation designed for 
small businesses

An affordable and 
easy-to-use first 
server solution to help 
protect data, organise 
and access business 
information on the go

A simple-to-manage, 
all-in-one server 
solution that allows 
users to stay connected 
while out of the office

Flexible and 
customizsable server 
platform providing 
reliable support for 
running demanding 
business workloads.

Features • Easily allows mobile 
and remote access

• Supports the 
deployment of 
both on and off-
premise applications 
with the ability 
to integrate with 
cloud technologies 
manually

• Recommended for 
small businesses with 
technology support 
providers or good IT 
knowledge in-house.

• Quickly connect 
to online services 
and cloud-based 
applications.

• Daily automatic 
backups of clients 
and servers

• Can be easily 
deployed and 
managed by 
individuals within 
organisations where 
there are limited in-
house IT skills.

• Increase data and 
network protection

• Automatic backup 
of business data 
and simple recovery 
features

• Stay connected to 
the business while 
out of the office

• Requires a higher 
degree of  IT 
knowledge to service 
than SBS Essentials.

• Innovative features 
for virtualization, 
power savings, and 
manageability

• Helps make it easier 
for mobile workers 
to access company 
resources.

• New functionality 
and powerful 
improvements to 
provide greater 
control and increased 
efficiency

No. of PCs Less than 15 users Less than 25 users up to 75 users unlimited number
of PCs

WHICH SERVER IS RIGHT FOR YOu?
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Whatever particular software package you select for your business, there is one universal question 
you must ask: Is it Genuine?
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Avoid nasty surprises!
www.getgenuine.co.zaYou won’t get away with pirated 

software in the long run. Sooner or 
later, your fortune will run out.
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Software Piracy

You may be tempted to download software from a suspect site. Or you may be a victim, conned into 
buying what you honestly think is genuine software, but then it turns out to be counterfeit.

The benefit of correctly licensed software is called the Genuine Advantage:

• Your productivity is enhanced by features, options and performance
• Software that is authentic and properly licensed is supported by a trusted partner
• Ongoing improvements, additional value enhancements and product innovations are available to you
• Genuine downloads and complimentary offers can be accessed from Microsoft.com 
 
Non-genuine software fast facts

Your PCs are not legitimately licensed if...

• They were acquired without pre-installed operating systems and then you used your Volume 
Licence Agreement to install Windows on them.

• They were acquired pre-installed with Windows Vista/XP Home versions and then you used your 
Volume Licence Agreement to install Business or ultimate versions on them

• You loaded one genuine version of software onto a number of PCs

• Your computer does not have a Certificate of Authenticity(COA). This sticker is not a licence itself - 
it is visual proof of whether or not the Microsoft software on the PC is genuine. This is how you find 
your COA:

AVOID NASTY SuRPRISES
BY INVESTING IN GENuINE SOFTWARE

Turn your PC upside downExample of COA:
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Also, your software may be counterfeit if it was downloaded and installed from online or unknown sources.

Please note that all Volume Licensing agreements are upgrade licences only and require a 
qualifying underlying licence. Microsoft Windows upgrades are designed to upgrade previously 
acquired qualifying licences. This means you must first have the full license for a qualifying 
underlying operating system for each PC before you install the upgrade. For more information on 
Windows operating systems versions that qualify for upgrades under Volume Licensing agreement 
programmes, visit www.microsoft.co.za/smb or www.getwindows7.co.za.
 
Being Genuine is more than just the right thing to do. Pirated software often contains viruses and 
malware which can pose a serious security threats to your business. In addition, it is the company 
director who is personally liable for crippling fines if his or her  business is found to be using 
counterfeit software.

So, is your software genuine?

If you aren’t quite sure whether your organisation’s PCs are running genuine software, you can check 
on www.getgenuine.co.za
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And what if it’s not?

Microsoft wants to help you go legit. Contact your local Microsoft partner and ask about Get Genuine 
Windows Agreement (GGWA) or Get Genuine Kit (GGK) licences. This is an agreement that assists 
organisations in legitimising their software.

AVOID NASTY SuRPRISES
BY INVESTING IN GENuINE SOFTWARE
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yeP, it iS....
free of LeGitiMacy...

free of SuPPort...
free of Security uPdateS

free of Peace of Mind!

do it! it’S
So eaSy!!! 
downLoad

that Software 
now!

it’S free!
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ExCLuSIVE TO GENuINE WINDOWS uSERS

Get real-time protection from viruses, spyware and other 
malicious software with Microsoft Security Essentials.

www.microsoft.co.za/smb

It’s a free download* from Microsoft that’s simple to easy to install and use, and is always kept up to date. Security 
Essentials runs quietly and efficiently in the background so that you are free to use your PC the way you want.
*Microsoft Security Essentials is available for small businesses with up to 10 PCs.

ANTI VIRuS
FREE
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Visit www.getwindows7.co.za
for more information
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There are so many clever features in Windows 7 that you might not have come across all of them 
yet. Here are some quick tips to make your life easier:

Navigation shortcuts

• Click on Start and begin typing the name of the program or document you are looking for. A 
list of options will appear for you to choose from, separated into categories such as Programs, 
Control Panel, Documents, Music, etc. If you click on one of these headings, all of the search 
results in that category will appear in a window. 

• To minimise everything except what you’re working on, click the top of that window, hold, and 
shake it. To bring the other windows back to their previous positions, shake the window again.  

• Put the programs you use every day right at your fingertips by pinning them to the taskbar. 
Simply drag the appropriate icon from the Start menu to the taskbar and reposition it among 
your other icons by dragging it left or right. Plus, with Internet Explorer 9 you can also pin your 
favourite Websites to the toolbar. 

• Access recent files and other shortcuts directly from the taskbar. Right click on the icon in the 
taskbar to open the Jump List, which has frequently used files, pinned files and possible tasks 
associated with that programs.

Run older applications in Windows xP mode

Get the best of both worlds by running your older Windows XP software right on your Windows 7 
desktop. If you have Windows 7 Professional, ultimate or Enterprise you can download
Windows xP Mode for free of charge from the Microsoft Website.

EXPLORE WINDOWS 7
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Painless Wireless
 
Wireless setup is really simple in Windows 7.

1. In the Notification Area (bottom right of the taskbar) click on the Network Status icon. 
2. Select the available network you want to join and click Connect. If the network is a secured one, 

you will need to enter a password.

Optimise your laptop’s battery life

1. In the Notification Area, click on the Power icon and select More power options. 
2. Choose between Balanced and Power saver settings, or click on More power options to 
adjust these settings manually. 

In sync with Windows Phone 

When you’re on the road with your Windows Phone, take notes using OneNote and 
update your contacts using Windows Live. When you get back to the office, open Internet 
Explorer on your PC and go to Windows Live SkyDrive. Open Devices/Phone and you will be 
able to access your OneNote docs and updated contacts. Remember that you’ll need to use identical 
Windows Live IDs on your Windows Phone and PC.

Lock up your laptop’s secrets

• use Encryption File System (EFS) to encrypt a particular file or folder on your hard 
drive that has sensitive or confidential information.

• use BitLocker Drive Encryption* to encrypt your entire hard drive so that it cannot 
be accessed by an unauthorised user. 

*Available with Windows 7 Professional (purchased with software assurance), Ultimate and Enterprise.
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Better memory consumption in Windows 7

Now that you’ve upgraded to Windows 7 from Vista or XP, you should be noticing that your 
PC is running better. This is because Windows 7, unlike the older versions, still uses the same 
amount of memory in spite of the number of windows you have open.

Set it and forget it with advanced Backup and Restore

Improved in Windows 7! Backup and Restore
creates safety copies of your most important files.
• Decide which folders, libraries and drives to back up, 

or let Windows choose for you.
• Back up to another drive or DVD, or even to a network 

(with Windows 7 Professional and ultimate)
• Schedule your backup – so you can set it and forget it. 

Restore previous versions

With Windows 7 you can get an old version of your
document back again! 

1. Right-click the file or folder and click Restore previous versions
2. Select a previous version from the list and click Open to check that it’s the 

version you want
3. Click Restore 

 

NB! The restored file or folder replaces the current version on your computer and this cannot be undone.

Microsoft recommends 
that you back up your 

files to a different hard 
drive to the one where 

Windows is installed.

EXPLORE WINDOWS 7
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You can also restore a deleted file or folder

1. Right-click on the folder that used to contain the file or folder and select Restore previous versions 

2. Double-click a previous version of the folder from the list 

3. Drag the file or folder that you want to restore to another location such as your desktop
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Here’s why:

Makes everyday tasks siMpler and easier WindoWs 
Xp

WindoWs 
vista

WindoWs 
7

Multi-task more easily a a a+ Windows Taskbar

Communicate and share with free photo, e-mail, and IM programs a a a Windows Live Essentials

Browse the Web easily and more safely a a a Internet Explorer 8

Find files and programs instantly a a+ Windows Search

Open the programs and files you use most in just a click or two a Pin Jump Lists

Navigate lots of open windows more quickly a Snap, Peek, Shake

Easily share files, photos and music among multiple PCs at home a HomeGroup

Print to a single printer from any PC in the house a HomeGroup

Simplify managing printers, cameras, music players and other devices a Device Management

Organise lots of files, documents and photos effortlessly a Libraries

Connect to any available wireless network in just three clicks a View Available Networks

Works the Way you Want it to WindoWs 
Xp

WindoWs 
vista

WindoWs 
7

Personalise your desktop with themes, photos and gadgets a a a+ Performance Improvements

Connect to company networks securely a a a+ Domain Join

Run lots of programs at once with better performance on 64-bit PCs a a a 64-bit Support

Built-in protection against spyware and other malicious software a a+ Windows Defender

Help keep your data private and secure a a+ BitLocker

Manage and monitor your children’s PC use a a Parental Controls

Run many Windows XP productivity programs a a Windows XP Mode

Designed for faster sleep and resume a Sleep and Resume

Improved power management for longer battery life a Power Management

Makes neW and eXciting things possible WindoWs 
Xp

WindoWs 
vista

WindoWs 
7

Watch and record TV on your PC a a a+ Windows Media Center

Create and share movies and slideshows in minutes a a Windows Live Movie Maker

Get the most realistic game graphics and vivid multi-media a a DirectX 11

Stream music, photos and videos around your house a Play To

Connect to music and photos on your home PC while away from home a Remote Media Streaming

Touch and tap instead of point and click a Windows Touch

  a = Included in this version of Windows  a+             = Improved in Windows 7

WINDOWS 7 IS SIMPLY BETTER!
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Historically, it’s always been a bit confusing trying to decide which edition of operating software was 
the right one to use. With Windows 7 it’s easy. All Windows 7 editions simply offer a more complete set 
of features than the edition before. 

Features

Make the things you do every day easier with improved desktop navigation a a
Launch programs and find the documents you use most often quickly and easily a a a
Make your Web experience faster, easier and safer than ever with Internet Explorer 8 a a a
Watch, pause, rewind, and record TV on your PC a a a
Easily create a home network and connect your PCs to a printer with HomeGroup a a a
Connect to company networks easily and more securely with Domain Join a a
Automatically send your documents to the right printer, whether you’re at work or at home,
with LocationAware Printing a a
Schedule a periodic backup to save data or an entire system to a network location or a local drive a a
Recover your data easily with automatic backup to your home or business network a a
Encrypt your files and folders to help protect confidential information a a
Run many older Windows XP productivity applications in Windows XP Mode*** a a
Help protect data on your PC and portable storage devices against loss or theft with
BitLocker drive encryption a
Work in the language of your choice and switch between any of 35 languages a

* NOTE: Windows 7 Enterprise edition is only available through a Volume Licensing Agreement with Software Assurance. 
** NOTE: Windows 7 Home Premium is not a qualified OS for Volume Licensing. 
*** Windows XP Mode requires either original equipment manufacturer (OEM) pre-installation or post-purchase installation of Windows XP Mode (which runs on 
Windows 7 Professional or Windows 7 Ultimate) and a virtualization technology such as Windows Virtual PC. Windows XP Mode requires a PC with 2 GB of RAM (32-bit) 
or 3 GB RAM (64-bit), 15 GB available disk space and a processor capable of hardware virtualization, with Intel VT or AMD-V turned on. Both Windows XP Mode and 
Windows Virtual PC can be downloaded from the Windows Virtual PC site. For more information on system requirements, go to the Windows Virtual PC site.

CHOOSE THE EDITION OF WINDOWS 7
THAT WILL BEST SuIT YOuR BuSINESS

Home Premium** Professional Enterprise* / Ulitmate
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Windows 7 contains:

A PROPER PLACE FOR 
EVERYTHING...
THINK OF WINDOWS AS YOuR TOOLBOX. 
IT HELPS YOu STAY ORGANISED, BuT IT’S 
LIMITED WITHOuT THE TOOLS.

*Separate free download for PCs running genuine Windows.

Windows® Media Center

*

*
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Office 2010 contains:

... AND EVERYTHING IN 
ITS PROPER PLACE

OFFICE 2010 IS LIKE YOuR COLLECTION 
OF TOOLS THAT BELONG IN YOuR 

WINDOWS 7 TOOLBOX. YOu NEED 
BOTH TO PERFORM AT YOuR PEAK.

** Available with Office Professional only.

Outlook2010

Access 2010

Publisher 2010

Word 2010

Excel 2010

PowerPoint 2010

OneNote 2010

**

**

**
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Hayden’s tweak (more purple at top) 7-21-10
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Hayden’s tweak (more purple at top) 7-21-10

Not only is Internet Explorer 9 faster and 
easier to use, but it also helps to protect 

your security and privacy. And what’s 
more, you can download it for free!

A MORE BEAuTIFuL
WEB - AND SAFER TOO!

Look at all these new and improved features:

One-click access to common tasks and favourite sites •  
Combined search and address bar for easy surfing and searching •  

Increased webpage viewing area  •
Tear-off tabs and Aero Snap  •

Improved control over browsing privacy  •
Resuming incomplete downloads after restarting  •

Improved protection against phishing attacks •

www.ie9.co.za
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31DISCOVER OFFICE 2010

The most common software tools used in the office environment are word processing (Microsoft 
Word), spreadsheets (Excel) and presentation software (PowerPoint). Then there’s Outlook for 
your mail and OneNote to help you keep your ideas organised. Office 2010 Professional also 
includes Microsoft Publisher, which helps you create high-quality materials such as newsletters 
and brochures without having any graphic design experience. 

MAKE THE MOST OF OFFICE

Create powerful data insights and visuals in Excel 2010 

use Sparklines to create small charts within cells in your worksheet to present a compact visual 
representation of your data.
 
To use Sparklines:
1. Select the cells in which you would like to 

place Sparklines
2. on the Insert tab, in the Sparklines group, click 

Line, Column or Win/Loss 
3. In the Create Sparklines dialogue box, select the 

associated values from which to create Sparklines 
(do not include data labels when selecting 
associated values.)

Customise your Sparklines:

1. Select cells containing Sparklines
2. The Sparkline Tools Design tab will display automatically. You will find options to change the 
Sparkline type, style and more
3. To remove Sparklines, use the Clear options.
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Share your Calendar

E-mail your calendar so it can be viewed by 
people outside your organisation, even if they don’t 
have Microsoft® Outlook® 2010 installed.

Trim your video within PowerPoint 2010

1. on the Home tab, click 
E-Mail Calendar in the 
Share group. 

2. the Send a Calendar 
via E-mail dialogue box 
opens. Specify your sharing 
options and click OK.

3. Your e-mail will be created. 
Double-check your calendar 
details, add recipients and 
send your e-mail.

1. Select the video, and the 
Video Tools will appear 
automatically.   

2. on the Video Playback 
tab, click on Trim Video in 
the Editing group. 

3. set the Start Time and 
End Time in the Trim 
Video dialogue box.

You can also insert bookmarks to jump to a specific point in your video. In the Video Tools, click 
the timeline to navigate to the appropriate place and click Add Bookmark on the Video Tools 
Playback tab. 
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Highlight trends & exceptions in Excel 2010 

Use Conditional Formatting to help you quickly visualise and comprehend data.
1. Select the applicable range of values. 

2. on the Home tab, click on Conditional Formatting in the Styles group. 

3. Select an appropriate conditional format from an available gallery. 

4. To further customise your conditional formatting, use the More Rules option at the bottom of 
the gallery.
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Keep track of your e-mail conversations in Outlook 2010

use Conversation View to reduce information overload and manage your email discussions by 
selecting Show as Conversations on the View tab.

To view the entire conversation: Select an e-mail and click on the arrow to the left of it to reveal 
all messages in the thread.

To remove redundant messages and save space in your inbox: On the Home tab, click on 
Clean up in the Delete group. You will find options to clean up the selected conversation (or all 
conversations) in the active folder or subfolders.

To ignore a conversation: On the Home tab, click on Ignore in the Delete group. The messages 
will be moved to your Delected Items folder, along with any future messages in the conversation.

MAKE THE MOST OF OFFICE
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Turn your images into works of art

use new and improved Picture Tools in some Microsoft Office 2010 applications to add a professional 
touch to your images from within your application. You can sharpen, soften, add picture effects and 
other styles, and remove the background.

1. Select a picture and the Picture Tools Format 
tab displays automatically.

2. Click Corrections in the Adjust group to Soften 
or Sharpen the image, and adjust Brightness 
and Contrast.

3. use Color to adjust the Color Saturation and 
Tone, or Recolor your image in sepia, grayscale 
or a color.

4. Click Artistic Effects to preview a wide range 
of effects. The Pencil Grayscale effect makes a 
photo look like a pencil drawing, while the Blur 
effect defocuses the image.

5. To isolate some parts of your image, click on Remove Background. The Background Removal 
tab will appear and the parts of the image that will be removed are highlighted. If you would 
like to change the selection, click on Mark Areas to Keep and use the mouse (with the cursor 
shaped like a pencil) to mark the appropriate areas. When you are satisfied with your selection, 
click on Keep Changes.
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Working with Protected View

Files that come from e-mail or the Internet are automatically opened in Protected View because 
they may be unsafe, indicated by a message bar below the Ribbon. At this stage the file cannot be 
edited. You can view the content before deciding whether you trust the document. Click Enable 
Editing on the message bar to close Protected View and proceed with editing.

You can manage Protected View settings in the Trust Center. 

1. Click the File tab to open Backstage view. Click Options then select Trust Center from the 
Options dialogue box. 

2. Click the Trust Center Settings button and then choose the Automatic Download tab to 
display your options.

MAKE THE MOST OF OFFICE

Protected Veiw             This file originated as an e-mail attachments and might be unsafe. Click for more details. Enable Editing
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Office 2010 
suites

New PC only Pre-installed on PC or Retail Packaged Product* Volume Licence only

Starter Home and 
Student

Home and  
Business Professional Standard Professional Plus

Word Limited  
Functionality

Excel Limited  
Functionality

PowerPoint

OneNote NEW NEW NEW

Outlook  (w/BCM)  (w/BCM)

Publisher NEW

Access®

Lync

InfoPath®

SharePoint 
Workspace NEW

Technical support 
included None 90 Days 90 Days 1 Year Included dependent on VL  

agreement

Office Web Apps Microsoft-hosted on Windows Live™
Licensed with Office Volume and 

deployed on SharePoint for  
manageability and control

Purchase 

Recommendations 

for customers

                       Home

Small Businesses

Mid-size Businesses

Estimated Retail Prices +/-R 1099 +/-R 1999 +/-R 4999

w/BCM - Available with Business Contract Manager.   *Product Key Card or Traditional Disc Media   

The new product lineup in Office 2010 provides simple and clear descriptions, making it easier for 
you to choose the product that fits your needs:

IT’S EASY TO FIND THE RIGHT
OFFICE 2010 SuITE TO MEET YOuR NEEDS
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Volume Licence solutions offer additional Server Integration capabilities with SharePoint Workspace, 
Lync 2010 and Exchange Server 2010:

View your social network feeds directly in Outlook 2010

Protect your emails from being forwarded, printed or edited

Manage your documents centrally and collaborate effectively.

Build your own dashboards for your company resources and
track your success.

Connect with people in and outside of your company via Instant 
Messaging, Voice and Video Conferencing and save on telephony cost.

Social Networking
Add On

Digital Rights
Management

Enterprise Content 
Management

Publishing Reports
& Analytics 

Instant Message,
Presence & Voice
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You can work in a familiar editing environment, using features 
that you already know. Collaborate easily with people in multiple 
locations, regardless of what version of Microsoft Office they 
have their computers or even if Microsoft Office is not installed.

To access Office Web Apps, you need SharePoint Foundation 
2010 (for business use) or a free Windows Live ID for (personal 
use).  You also need an appropriate device, an Internet 
connection, and a supported Web browser, such as Internet 
Explorer 7 or later, Safari 4 or later and Firefox 3.5 or later.

*There are some differences between the features of 
Office Web Apps and the Office 2010 programs.

Extend your Office experience to the Web for free with Microsoft Web Apps. You can get 
more done wherever you are - in the office, at home or on the road. These convenient online 
companions to Microsoft Word, Excel, PowerPoint and OneNote offer you a simple way to 
access, view, and edit documents directly from your Web browser*.
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Create and edit documents 
from virtually anywhere1. Web Apps let you edit your documents in a Web browser

when you’re away from your office, so you don’t need to
wait until you get back to your desk.

Share and protect
documents2. You can easily share documents in password-protected 

folders and assign view-only or view-and-edit 
permissions to the people you choose. You can also 
specify certain documents that can be shared with 
everyone so that no password is required.

Access Office documents 
across platforms3. You - and the people you share your work with - can 

access Office documents across platforms easily because 
Office Web Apps supports a wide range of browsers 
(Internet Explorer, Safari and Firefox) and Office versions 
(2003, 2007, 2010 and Microsoft Office 2008 for Mac). 

High-quality
viewing experience4. View your documents online in the Web browser on

your PC, or Mac, with the kind of clarity you’re used to 
with your Office client software. Documents created with 
Office applications retain all their formatting and data 
when viewed online with the Office Web Apps.

Collaborate
simultaneously5. Edit documents and share ideas with other people in 

real time with co-authoring. With Excel Web Apps and 
OneNote Web Apps a number of people can work on the 
same document simultaneously from within the browser.
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unplug, you have nothing to lose but the constraints of your office! Find out how to work, 
communicate and get online wherever you want to work.

Technology has set us free to work wherever and whenever we want. Whether we’re calling clients 
on our cell phones or picking up email and getting work done on a smartphone, nearly every 
entrepreneur benefits from mobile working. Are you getting the most out of your technology? 
Could your staff benefit from more flexibility?

Mobile working - using technology to work at home, when 
you’re with clients or almost anywhere else - has grown 
enormously in the last few years. No wonder. The benefits are 
clear: You can respond to clients much faster, choose your 
working hours and workspace and improve productivity.

WORK ANYWHERE YOu WANT
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Getting online

There are two main ways to get online 
when you are not connected to
the Internet in your office:
 

• Wireless networking (Wi-Fi): Most laptops and smartphones can use this technology and it is 
capable of high-speed links, but it can be difficult to find an open connection when you are away 
from your base station.  
 

• 3G mobile broadband: This uses the cell phone network to make a data connection to the 
internet. You have to pay for the connection wherever you are, so it’s like using your cell phone 
except that you pay for the amount of data you use rather than the length of your calls. A 
downside of 3G mobile broadband is performance. If you have a good connection, you can 
get broadband speeds but if you’re moving around or in a poor coverage area, things can slow 
down. 
 

The best approach is to have both options and use Wi-Fi whenever possible. That way you should 
be able to get online almost anywhere but still get low-cost, high-speed connections when you 
need them most.

Two for the price of one 
Microsoft Office 2010 Home & Business 

and Professional include a licence that 
allows you to install the software on your 

desktop and laptop, providing that you 
are the primary user on both machines. 

This cuts the cost of using the latest 
applications when you’re out of the office.
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• Free online storage and sharing of files with 
Windows Live SkyDrive 

• With Microsoft Office Web Apps you can 
view and edit Office files using Web-based 
versions of your applications. use Microsoft 
Word Web App to make a quick change 
to a report or print a document on the 
go. update budgets and edit formulas 
with Microsoft Excel Web App and be 
prepared to deliver your presentation any 
time with Microsoft PowerPoint Web App. 
Microsoft OneNote Web App gives you one 
convenient online place to keep all of your 
ideas, making it easy to stay on top of your 
important information. 

• use the Sync Center in Windows 7 to 
synchronise files on your laptop with files on 
your office computer or server. You can also 
use Microsoft SharePoint, a private Website 
and file sharing system, to store files and 
share them with colleagues. 
 

• Hosted software: See page 47 for more on 
cloud computing.

• Microsoft Exchange Server ensures that you 
and your staff can email one another, share 
calendars and contacts and keep everything 
synchronised between smartphones, PCs, 
notebooks and even access a web-based 
email client. You can run Exchange on 
a Windows Small Business Server 2008 
computer in your office – and get the 
benefits of an on-premises server such as 
greater control, flexibility and support for 
networked computers.  

• For smaller businesses that don’t need a 
sophisticated email system, Microsoft Office 
Live gives you web-based email, calendar 
and contacts.

Tools for remote working

WORK ANYWHERE YOu WANT



44

More glance
and go.

Quickly see everything you care about
with the Live Tiles on your Start screen.

7

Customise and be continuously updated using your Live Tiles on Windows Phone. One glance tells you what’s going 
on, what’s happening next, what you’ve missed. Depending on the app, Start’s animated Live Tiles might show pending 
messages and appointments, news and weather, or game and friend status - all refreshed wirelessly via the web. It’s also 
yours to decorate: pin people, apps, playlists, pictures, and other favorites to Start so they’re always at your fingertips.

Less stop
and stare.

For more information visit www.windowsphone7.co.za
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Mobile working tips 

• Invest in a smart phone such as Windows Phone 

• Keep a laptop power supply at home and a duplicate at the office so you don’t need to keep 
carrying it back and forth 

• use a docking station to turn your laptop into a desktop when you need to 

• Back up! use an online backup strategy so your files are stored safely whenever you are 
connected to the internet and not just when you’re in the office  

• use a portable mouse with a laptop. It’s better for your hands than by using a laptop track pad 
all day. 
 
Make your e-mail work for you

• The power of your e-mail identity: Web-based e-mail systems like Hotmail are great for 
private e-mail but using these for business is unprofessional and can influence the perception 
of your company. Sending a prospective new client an e-mail from sue@brilliantevents.co.za, 
for example, is far more powerful than sue15@hotmail.com. Not only does this create a more 
professional impression, it also makes a new contact immediately associate you with the image of 
a business as opposed to an individual. Your e-mail address should become a hard-working, subtle 
brand builder.  

• Get your company e-mail address: Check on http://whois.co.za/whois.shtml whether your 
choice of domain name is available and then contact your Internet Service Provider (ISP) to about 
registering the domain and setting up your mailboxes. Now that you have the domain, set up your 
own Website. These days customers expect businesses of all sizes to have one.

WORK ANYWHERE YOu WANT
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Microsoft Exchange Server 2010 can effectively deal with your incoming 
and outgoing mail and will filter out unwanted spam e-mail before it even 
reaches your company inboxes. Hosted solutions also reduce your IT 
risks and costs, offer 24/7 support and charge predictable monthly costs. 
Exchange Server will allow you to: 

• Manage e-mail, calendar, tasks and business contacts from one place, 
and share your calendar with anyone inside or outside your organisation

• Access e-mail, calendar and contacts from virtually anywhere. 
 

 

POP3 vs IMAP. If you don’t get your own server, make sure you set up your 
e-mail accounts as IMAP (Internet Message Access Protocol) accounts and 
not POP3 (Post Office Protocol). IMAP allows multiple e-mail packages from 
different locations to access the same mailbox and mail messages remain on the 
remote mail server until the user explicitly deletes them.  
 

Microsoft Enhanced Communication and Collaboration solutions 
enable you to send e-mails, access shared documents and schedule 
appointments directly from your PC, browser or phone. You can also have 
real-time online meetings and instantly connect with colleagues through 
instant messaging.

WORK ANYWHERE YOu WANT
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any idea what 
this cloud stuff 

is about?
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1. What is cloud computing? 

Also called software-as-a-service, cloud computing means running applications over the 
Internet rather than on your own PC. Examples from Microsoft include: 

• Web services such as Hotmail and search engines such as Bing  

• Business applications such as Microsoft Office Web Apps  

• File storage and sharing services such as Windows Live SkyDrive  

• Customer relationship management applications such as Microsoft Dynamics CRM Online. 
  
2. What can it do for my business? 

Ten years ago, if you wanted big company IT, you had to buy your own servers and install 
expensive software. Nowadays you can use the Internet to access services such as e-mail, backup, 
file storage and sharing, document collaboration, customer relationship management, HR 
applications and Web conferencing.

Cloud computing also reduces IT costs, allows you to carry on working if something happens to 
your computer, provides secure storage for your data and gives you access to new services and 
easy upgrades. You can maximise productivity and stay focused on business-critical needs without 
having to invest in expensive IT infrastructure or additional staff.

3. Why is everyone excited about cloud computing? 

Cloud computing delivers significant benefits because of the way it works: 

New business models: Typically, you pay for cloud computing applications on a per user, per 
month basis rather needing to pay up front for hardware and software. This gives you a predictable 
price that goes up and down as your usage changes. Also, it is an operational expense for tax 
purposes rather than capital expenditure, which simplifies your accounting. 

10 QuESTIONS EVERY BuSINESS MuST
ASK ABOuT CLOuD COMPuTING
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Economies of scale: It is much more efficient for you to ‘rent’ five percent of a server from a 
cloud service than it is to buy 100 percent of your own. 

Cost savings: Because it is so efficient, it is also usually cheaper. For smaller businesses, cloud 
computing gives access to services that are often too expensive to run in-house, such as hosted 
Intranet sites or communication systems. 

Best practice IT: Cloud vendors deliver higher levels of security, reliability and availability than 
most businesses can manage in-house. 

In short, cloud computing is an attractive form of outsourcing that gives you easy access to 
advanced technology. 

4. How much does it cost? 

As you would expect, prices vary from service to service and vendor to vendor. Although many 
online services are free, they come with adverts and may not be suitable for business use. 

5. How do I evaluate different services? 

Don’t look at any single factor. Start by carrying out a basic analysis of your business needs, what your 
employees will do with the system, which benefits are ‘must-haves’, and what your alternatives are.

You should look at your budget not just in terms of saving costs on your current system, but also 
in terms of what new capabilities the technology can offer and how you can make use of the new 
features and opportunities.
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6. Is it right for me? 

There are some reasons why you might not want to use cloud computing: 

• Your Internet connection is very slow or unreliable 
• You want, or need, absolute physical control over your data 
• If you run a specialist line of business applications, you may not be able to integrate it with 

some cloud-based systems. Consult with your Microsoft Partner to ensure that it does. 
• You need highly customised software or bespoke applications. Cloud computing tends to work 

on the ‘one-size-fits-all’ model. Once again, a knowledgeable IT partner can be really helpful. 
E-mail mssatalk@microsoft.com and a Microsoft Partner will contact you.

7. Can I test it?  

It’s a good idea to sign up for a trial period and run a new cloud service in parallel with your 
existing systems for a while to iron out any kinks and explore new features and benefits.

8. Where is my data stored? 

Before signing up, check where your data will be stored. Look for confirmation that the data 
centres are secure and well run. For example, Microsoft has nine layers of best-in-class security 
measures, including intrusion detection systems and multiple data centres to provide a fully-
operational backup.

   

  
 

CLOuD COMPuTING
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Easy access to multiple communication modes through a 
simplified interface, allowing users to connect and collaborate 
from anywhere.

9. Can I get my data back? 

You need to be sure that you can get your data back in a useful format if you decide to switch
Providers, or move to a different system. For example, Microsoft gives you a choice between
Microsoft-hosted, partner-hosted, or on-premises systems and provides tools to move data, such as
emails, from one system to another.

10. How do I evaluate suppliers? 

You should find out about a provider ’s size and reputation, track record in your industry sector, or 
organisation size, support options, future options, amount of training required for your staff, data 
protection, service level agreements and obviously pricing structure.

SOLuTIONS AVAILABLE FROM
MICROSOFT HOSTING PARTNERS

A full-featured hosted email, calendar and contacts solution 
delivered as a service by Microsoft.

A central place to share documents and information, making 
it easy to work together with colleagues and customers.

A fully integrated suite of marketing, sales and service 
capabilities.
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FOLLOWING FREE SOLuTIONS:

The efficient way to do e-mail, with the ability to work with
Word, Excel, and PowerPoint files right from the user’s email.

Save files to the Cloud: get free online storage on 
SkyDrive. use it to save your files or share photos and videos.

Social networking and updates, together with features for 
video chatting and uploading photos at the same time.

Keep your files in sync. Now you can stop emailing files 
to yourself. Keep docs, photos, and other files in sync across 
your PCs.

Stay in touch and share your world with Windows Live
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Store, access and share thousands of documents, photos and Microsoft Office files 
on Windows Live SkyDrive. SkyDrive password-protects your files so you control 
who has access to them. Visit www.microsoft.co.za/smb for more information.

ONLINE STORAGE
FREE 25 GB OF



54 FINDING AND KEEPING CuSTOMERS 
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Set up a Website and keep it up to date: Without 
a good online presence, people can’t find you. You can 
get a custom-designed interactive site done through 
a design agency, but there are also do-it-yourself 
template-driven solutions available on the Web.

Social media marketing: Don’t underestimate the 
power of exposure in this sphere.  See page 58 for 
more on this topic.

Create your own marketing materials: Microsoft Publisher 2010 is as easy to use as 
Microsoft Word and it comes with a host of free templates to get you started. You can also 
download free clip art from the Microsoft Office Website www.office.microsoft.com/en-za/ or 
from a  public domain library. 

FINDING AND KEEPING CuSTOMERS 

No marketing, no customers, no sales: It’s as simple as that!

It’s not true that if you build it, they will come. If they don’t know about it and don’t know why 
they should come, they’ll stay at home. But the good news is that marketing has become more 
measurable and cost-effective in the digital age. Here are some ideas for taking advantage of new 
marketing options.

Generating new leads 

There are many tried-and-tested techniques for generating new customer leads: 

Use Mailmerge in 
Publisher to personalise 

brochures and 
newsletters.
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Search engine optimisation: It’s important that your name appears at the top of the list when people 
search for your products or services in a search engine like Microsoft Bing. Here are some things you 
can do to improve your searchability without spending any money: 

• Register your Website with the leading search engines 
• Add your shop, or office, to search engine maps 
• Download Microsoft’s Free SEO Toolkit (http://www.microsoft.com/web/seo/) to get an in-depth 

analysis of your Website and help with making changes to boost its search engine ranking.
• Encourage other people’s sites to link to yours. This will enhance its credibility and relevance.

• Online advertising: You can also advertise on search engines against keywords and your company 
name. You only pay when someone clicks on the advert and goes to your site and you can set 
budgets on how much you want to pay per click. To find out more about advertising with Microsoft 
adCenter in South Africa, go to www.digitalmark.co.za. 

Direct mail and electronic direct mail: DM (direct mail) and eDM (direct mails by email) can be very 
effective ways of reaching new customers and keeping existing customers up to date. You can send 
personalised emails to your mailing list from Microsoft Word or Publisher 2010. 

Getting your customers to touch 
and connect with your product 
or service is vital. A free sample 
or free trial can give you a good 
reason to contact prospective 
customers without giving them 
the hard sell. 

FINDING AND KEEPING CuSTOMERS 
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It is 5-10 times cheaper to keep an existing 
customer than to acquire a new one. If you 
don’t devote time and resources to building 
relationships with your customers, you could
lose them.

A successful Customer Relationship Management 
(CRM) strategy means that you always put your 
customers at the centre of everything you do. 

CRM software keeps track of sales opportunities, 
customer records and contact histories. It can 
be a very powerful way of automating the sales 
and marketing process and building long-term 
relationships.

The system really helps when you have more 
than one person dealing with customers because 
it ensures that everyone has access to the 
same information. Having everything about a 
customer stored in the system means that if a 
staff member is away on leave, someone else in 
the office can easily help them.

To track all your interactions with clients use 
Business Contact Manager, which integrates with 
Microsoft Outlook 2010. It keeps a local copy of 
all the data on your laptop while you’re on the 
road and then resynchronises any changes when 
you get back to the office.

But CRM is not just an IT project. It is a business 
initiative, which means that your organisation 
needs to understand the technology and what it 
can and cannot do. If you want your people to 
use it properly, you will need to invest in some 
training for them.

If you’re storing personal 
information, you need to 
be aware of the legalities 

surrounding the
Data Protection Act.
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Social networking isn’t just for kids and weekend parties. It’s also for 
business. Discover new ways to reach prospective clients, promote your 
business online and get more information about your existing customers.

Social networking is the catch-all name for Websites that let visitors interact with one 
another and with companies. If you want to talk to potential customers, you need to 
go where they are and that means social networking.

Social media looks a lot like public relations. You want to tell your story and 
put your company in the best possible light. However, there are some striking 
differences. At heart, effective use of social media is about creating and 
sustaining a conversation and, if you’re successful, a community. This means 
interacting with readers and visitors. It’s not a one-way medium.

The business benefits of social media include the opportunity to: 

• Monitor opinions about your company, its products and services 
• Get new ideas for products, services and improvements 
• Create a ‘tribe’ of loyal customers for word of mouth 
• Recruit new staff from a wider pool 
• Raise your profile and generate PR, particularly around company news 

Using Outlook 2010 to stay in touch with your networks

Get LinkedIn and Facebook profile information about your network 
right inside Microsoft Outlook 2010 using the Outlook 2010 Social 
Connector. It’s a great way to stay in touch with your contacts and 
see the information they publish about themselves when you are 
ready to communicate with them. 
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Microsoft and Richard Tubb of Certified Partner James Cash suggest some easy ways 
to build your online reputation and gain a following: 

SOCIAL MEDIA TIPS 
From Microsoft and Digital Marketing Strategy Lead, Allister Frost 
• Don’t give up too soon - it will take time for your network to grow and become self-sufficient 
• Enough with the hard sell! On the social Web, people expect a little more subtlety. Try to sell them 

something and there’s a good chance they will leave. The big opportunity with social media is to 
build a trusted relationship and a strong brand

• Don’t forget that social media is a public discussion. You don’t get to control what people say about 
your company or products. It pays to plan out how to handle complaints, criticism and common 
questions in advance. Generally the best advice is to be respectful and helpful. 

• be interesting
• Provide expert advice that people find 

trustworthy and useful
• Show the love. Follow other people on Twitter, 

add people to your network on LinkedIn. 
Comment on other people’s blogs. In other 
words, contribute! 

• Fish where the fish are: Some people use 
LinkedIn, some Facebook, and some Twitter. 
use tools to make sure you engage with all of 
those people regularly

• Social media isn’t about putting your message 
out, it’s about starting conversations. Make sure 
that conversation is a two-way street 

• Be regular and consistent: If possible, try to 
spend a little time each day contributing to the 
community and interacting with people 

• Promote your online activities everywhere: In 
your email signature, your letterhead, your 
business card, your Website, etc. 
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With Open Value Subscription (OVS), you can get
Windows 7 Professional + Office 2010 Professional for less than the cost of a cappucino a day!

YES IT’S TRUE!

...But if we all
give up just one cup 

of coffee a day, we’ll 
be able to afford 

the latest Microsoft 
software.

Volume Licensing - the way to 
afford up-to-date technology
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Microsoft Volume Licensing is a simple and cost-effective way to purchase multiple licences under a 
single agreement. This type of software licensing is the best option for businesses that plan to grow 
because it provides a seamless management and procurement process. 

Benefits of Volume Licensing:
       
• Discounts for five or more PCs
• Flexible payment schedules
• Software Assurance* increases your technology value by giving you access to a set of benefits that 

help you manage costs, stay current and increase productivity. The advantages include:
• Next Version Rights
• Valuable Support
• Access to training
• Mobility Rights
• Home usage Rights
• Deployment advantages
• e-Learning

For more information on these benefits, download our licensing guide from www.microsoft.co.za/smb 
(and select Licensing Guide).

*Included with Open Value and Open Value Subscription, and optional with Open Licence.

VoluMe lIceNsINg
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But if renting your software licences is not a suitable option for you, there are two 
other options for volume licensing: 

Open Value Licence

You own a licence for all the PCs in your organisation (minimum 
of five), including upgrades, and pay it off by a predictable 
annual fee for three years.

Open Licence

This is an entry-level programme where you place an initial order for five 
or more licences or one server licence. As with Open Value, you own the 
licence indefinitely and pay for it over three years.

Open Value Subscription        

With Open Value Subscription (OVS) you rent your 
software licences for a set period and renew them at 
the end of the term.

The benefits of OVS include:
• Lower up-front costs
• The option to increase or decrease the licence count annually
• Possible tax savings because your subscription can be treated as operational expenditure
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Too few PCs for volume licensing?

Volume licensing only applies for five or more PCs. For very small businesses there are two other 
software licence options: 

Original Equipment Manufacturers (OEM)

The software is already installed when you buy the PC, so it is ready to 
use but can only be used on that computer. You can also add Software 
Assurance to this option. This is the best alternative for small businesses
with minimal IT requirements.

Full Packaged Product (FPP)

You buy the software from a retailer or online and install it easily on a single PC. Although this is more 
expensive per unit, it is ideal for small businesses needing less than five software licences.

VOLuME LICENSING OPTIONS

Another way to purchase your 
software licences is through Hosted 
Solutions. See page 47 for more 
about cloud computing.
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www.nsbc.org.za

The National Small Business 
Chamber (NSBC) is a dynamic, fast 
growing non-profit membership 
organisation that is committed to 
the success of your business.
 
Our entire focus is geared on working for our members; 
helping them grow and succeed beyond the norm.  We 
don’t do ‘ordinary’; we’re here to assist with innovative and 
exciting ideas, networks and platforms that will positively 
affect your bottom line and overall business standing.   

Are you ready to give your business that extra edge? As one 
of the fastest growing organisations of its kind in the world, 
the NSBC promises to help you…GROW, LEARN, NETWORK, 
CONNECT, BE INSPIRED AND HAVE FUN.
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HELPING YOu MANAGE 
YOuR SMALL BuSINESS

Financial
Management

Purchasing

Projects

Business
Analytics

Sales

CRM

Mails

The South African SME Toolkit is a joint initiative 
between Business Partners, the leading risk financing 
company for small and medium enterprises, the 
International Finance Corporation (IFC) and IBM. 
The Website offers easy access to information, 
resources and online training relevant to small, 
micro and medium enterprises (SMMEs) across 
various industries and business sectors.  The SME 
Toolkit South Africa is aimed at any entrepreneur 
looking to start or grow their business.

The Website provides how-to articles, financial 
tools, online training and information resources 
developed by leading experts. All aspects 

of business management are covered, from 
business planning to accounting, financial 
management, human resources, import and 
export, legal matters, marketing, sales, operations 
and information technology.  Whether it’s a 
budget spreadsheet, policy document or forms 
needed for tax filing, the SME Toolkit is a one-
stop business management shop.

Start making use of the handy information and 
tools immediately. By registering on the Toolkit, 
you will receive the monthly newsletter, special 
offers and a free business listing.

To access the site, visit: http://southafrica.smetoolkit.org
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Get the most out of your accounting software.
   Get skills for life with
                Pastel Training. 
  Running a small business can be challenging. Suppliers, cashflow, employing the right people and 

managing your finances are just a few of the issues business owners face on a daily basis. Become 
more efficient in the way you work by signing up for Pastel Training. 
 
With over 500 training centres across South Africa, and over 20 000 people completing Pastel Training 

every year, isn’t it time you gained a skill that will stay with you for life?

Contact the Pastel training team on +27 11 304 3670 or visit www.pastel.co.za for further 
information.

JHB +27 11 304 3000   DBN +27 31 537 7100   CT + 27 21 522 7400

MSboss_DPS.indd   3 2011/06/06   2:32 PM

Pastel Training Q & A
with Kumbirai Gondo
 
Which Pastel Training course did you attend?
I attended the Pastel Xpress course which was a three day course that included self study 
and facilitated workshops, and I have six months in which to write the online assessment.

Did you find the training course worthwhile?
Yes, it was definitely worthwhile. I got practical experience that I will be able use again and 
again. I learned everything from setting up a company to doing the monthly processing. 

How has it changed the way you do your job?
I use Pastel on a daily basis and I used to follow the steps but never really understood why 
I was doing certain things. After attending the course, I have a clear understanding of the 
program, the processes and I feel much more comfortable in the way I do my job.

Would you recommend Pastel training to colleagues?
Absolutely, I have already recommended it to two of my friends who I know would benefit 
from the training.
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Get the most out of your accounting software.
   Get skills for life with
                Pastel Training. 
  Running a small business can be challenging. Suppliers, cashflow, employing the right people and 

managing your finances are just a few of the issues business owners face on a daily basis. Become 
more efficient in the way you work by signing up for Pastel Training. 
 
With over 500 training centres across South Africa, and over 20 000 people completing Pastel Training 

every year, isn’t it time you gained a skill that will stay with you for life?

Contact the Pastel training team on +27 11 304 3670 or visit www.pastel.co.za for further 
information.

JHB +27 11 304 3000   DBN +27 31 537 7100   CT + 27 21 522 7400

MSboss_DPS.indd   3 2011/06/06   2:32 PM



68 APPENDIX: BACK TO BASICS

CPu (Central Processing unit)

The speed of a PC’s Central Processing unit will impact on how fast a PC is going to
be. The speed is measured in Gigahertz (GHz), units of frequency. The higher the GHz of
the CPu specification, the faster that PC will be. To check on the processor speed and RAM
of a PC, click the Start button, then Control Panel and finally System.

RAM (Random Access Memory)

RAM is the temporary working
memory that your PC needs while
you work on your files.  Most desktop
computers now use a type of memory
called DDR3. Memory speeds impact
on performance. The faster the memory, the better the performance will be. When buying memory 
keep in mind that buying as few DIMMs (Dual In-line Memory Modules) as possible will allow for 
future memory upgrades. 4GB of RAM is recommended for an optimal experience.

Hard drives

A hard drive is the mass storage device in your PC and is the place where you store 
data such as your PC’s operating system, applications and your documents. Hard drives 
basically come down to size and speed. The larger and faster the drive, the better the 
performance and capacity. For a desktop, Microsoft suggests at least 500GB of storage 
space. In terms of speed, most run at 7200 rpm (revolutions per minute).

A PC which has DDR2 listed under its 
RAM specifications, is probably a less 

expensive, budget classed system and is not 
recommended. Make sure you get DDR3.
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Monitors

When it comes to monitors, size counts. The entry-level size is a 17-inch 
monitor. Larger monitors offer a better experience, less scrolling when 
browsing the Web and they are easier on your eyes. Of course, if you’re 
using your PC for graphic design or video editing, your monitor should be 
a 22-inch at the least.

Network connections

A network facilitates interactions among users and allows them to share 
resources with each other. The two most common connection methods 
that you’ll come across in the small business environment are Ethernet 
and Wireless LAN (Local Area Network).

Ethernet uses physical wiring to connect devices and requires devices like 
hubs, switches, bridges and/or routers. Wireless LAN technology is designed to connect devices 
without wiring and these devices use radio waves or infrared signals as a transmission medium.

Wireless technology is often sufficient 
for small to moderate usage, but wired 
networks are faster and more stable. 
Ethernet should be the preferred 
choice for desktops on a network, 
especially in an environment that 
needs to cater for growth.
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Operating system

Windows 7

Whether you’re buying a new PC or upgrading an old one, Windows 7 is a must. Old versions of 
Windows in comparison to Windows 7, simply don’t have the same high-end security features and 
technological advances that ensure safe computing and the ultimate user experience. See page 19 for 
Windows 7 tips.

If you buy a new PC with Windows 7 pre-installed, make sure that the edition that is installed is 
Windows 7 Professional.

Anti-Virus software

Essential protection

Anti-virus software is a must on all PCs. It is a computer program that detects, prevents and takes 
action to disarm or remove malicious software programs, such as viruses and worms. See page 18 
to find out about Windows Security Essentials, which can be downloaded free if you have genuine 
Windows.
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71

Distributed by Microsoft South Africa
3012 William Nicol Drive, Bryanston, South Africa

© Copyright 2011. All Rights Reserved

www.microsoft.co.za/smb



© Copyright Microsoft South Africa 2011. All Rights Reserved


